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CSiBridge® Version 21.2.0 
Release Notes 

© Copyright Computers and Structures, Inc., 2019 

Notice Date: 2019-11-13 
 
 
This file lists all changes made to CSiBridge since the previous version. Most changes do not affect most users. 
Items marked with an asterisk (*) in the first column of the tables below are more significant. 
 
The reference number for each change below is now the development Ticket rather than support Incident which was 
used in previous Release Notes. Emails sent when an Incident is released will now indicate this Ticket number as well. 
 

Changes from v21.1.0 (Released 2019-08-22) 

Analysis 
Enhancements Implemented 

* Ticket # Description 
* 2853 An enhancement has been implemented to more clearly display and save messages generated 

during analysis runs. These are the same messages that appear in the analysis LOG file, but 
provided in a more concise format. Analysis messages are categorized as information, 
warnings, and errors. After the analysis is run, messages are automatically displayed as text if 
they are any warnings or errors in the latest run. This same text display is available any time 
using the command Analysis > Messages. The messages are also available in tabular format 
under table Analysis Results > Run Information > Analysis Messages. Messages are cumulative 
with subsequent runs until the model is unlocked, at which time the messages are deleted. Each 
message includes its type, message text, associated load case or stiffness case, operation being 
performed, date-time stamp, parallel run tag, run serial number, and machine name. The run 
serial number counts subsequent runs before the model is unlocked. The parallel run tag 
indicates which thread was used when analyses are run in parallel during the same analysis run. 

Bridge Design and Rating 
Enhancements Implemented 

* Ticket # Description 
* 2278 A significant change has been made to how longitudinal stresses are calculated in the steel 

flanges for steel I-girder bridge sections. This affects the stresses plotted in the Bridge Object 
Response Display form and used for stress-based design and rating requests. When the bridge 
object is modeled using area objects and the steel I-girders are modeled using shells or the 
mixed model (shell web, frame flanges), then stresses are calculated using section cuts. 
Previously, longitudinal stresses in the flanges were always calculated using a section cut 
consisting of only the flange itself. Stresses calculated this way account for distortion of the 
cross section due to shear and torsion, but can also be overly sensitive to local effects, such as 
change in thickness of the flange plates. Now stresses are calculated as follows: 
1. For the stress points at the top center of the top flange and bottom center of the bottom 
flange, the stresses are calculated based on the entire I-girder section (web plus both flanges) 
with the reasonable assumption that plane sections remain plane, since there is no warping 
effect along the center-line of the web, and the web distortion effect on the major-axis bending 
stresses is insignificant. Some jumps in the stresses between longitudinal stations are to be 
expected due to shear between the steel I-girder and the slab, if present. 
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* Ticket # Description 
2. For the stress points at the four corners of the I section (ends of the flanges), the section cut 
includes the web and the corresponding flange. For the top flange, this is a T-section that 
includes the top flange and web. For the bottom flange, this is an inverse T-section that 
includes the bottom flange and web. This approach reasonably accounts for warping, but is still 
not overly sensitive to changes in plate thickness. Some jumps in the stresses between 
longitudinal stations are to be expected due to shear between the web and the excluded flange. 
3. For the flange lateral-bending stress, the previous method of considering only the flange 
itself in the section cut is maintained. 
The new results tend to be smoother, exhibiting smaller jumps at longitudinal stations, and yet 
they still accurately capture warping behavior that can be significant for some models. Design 
and rating results may be affected, but will generally tend to be slightly less conservative 
because smoothing tends to reduce the peak stresses. This enhancement does NOT affect: (1) 
Bridge objects updated as spine models, (2) Steel I-girders modeled as frames (not as shells or 
mixed models), (3) Stresses in the slabs, or (4) Design and rating requests based on forces and 
moments, rather than on stresses. 

* 2376 A new bridge superstructure design request has been implemented for concrete box girder 
bridges that can determine the total area of tendon steel required to limit tension and 
compression stresses under permanent and service load conditions. Typically, a single tendon is 
drawn for each span or set of spans and a prestress load is defined that produces the desired 
tension stress in the tendon. The design request will then calculate a single scale factor that 
multiplies the given tendon area as required to satisfy stress limits specified for both a 
permanent load combination and separately for a service load combination. Stresses are 
checked at the top and bottom fibers at the horizontal centroid of the bridge section. Stresses 
can be plotted before and after scaling at each section cut along the length of the bridge object. 
Areas where the tendon elevation is such that no scaling can satisfy the stress limits will still be 
plotted and can be used to guide changes to the tendon profile. If the scale factor found is 
significantly different from unity, it may be necessary to re-run the analysis and design with the 
new tendon area, since the tendon itself can have an effect on the stress distribution in the 
section. Mild steel reinforcement can be added later to satisfy strength limit states. Once the 
total tendon area is determined, the single tendon can be copied to multiple transverse 
positions, if desired, and all tendons scaled so that the total calculated tendon area is 
maintained. This new design request is based on guidelines from the California Department of 
Transportation (Caltrans); see http://www.dot.ca.gov/des/techpubs/bdp.html. It is available no 
matter which bridge design code is selected. As part of this enhancement, the default tendon 
profile generated by the Quick Start template for bridge tendons has been changed so that the 
vertical location at the start and end of each tendon is at the vertical centroid of the bridge 
section. This new design request is now automatically created by the New Model template for 
concrete box girder bridges if design requests are selected to be generated. 

* 2879 Bridge rating for the axial capacity of truss members has been implemented as new frame-
member rating requests of type Axial Service and Axial Ultimate. Factored axial resistances 
(tensile and compressive) can be assigned to any frame member for either the Service or 
Ultimate limit state, or both. Rating requests can be defined that specify the portion of the 
structure to be considered, the live load to be rated, as well as the existing loads that reduce the 
capacity available. The resulting rating factors can be plotted as colors on the model with 
optional numerical values shown, and are available as tabular output. This feature can be used 
on structures created by the Bridge Modeler or defined manually. 
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Bridge Modeler 
Enhancements Implemented 

* Ticket # Description 
* 1324 The Bridge Modeler has been enhanced for steel I-girder bridges to allow easier specification of 

girder (steel beam) plates sizes and vertical web stiffeners prior to running analysis and bridge 
design or rating. Previously these options were only available after running bridge design or 
rating using the Optimize command. This new feature is accessed using the command Bridge > 
Spans > Steel Beam Editor. Plate sizes can only be edited when the model is unlocked, but the 
vertical stiffeners can be edited whether the model is locked or unlocked. 

 2993 An enhancement has been implemented for the Bridge Modeler where a default bridge group is 
now created for each bridge object that is to be used for bridge tendon loading. This bridge 
group contains all of the superstructure except diaphragms, and bridge tendons now default to 
using the new group for the parameter Group Loaded By Tendon. This avoids the problem 
where bridge tendons could load a diaphragm, which would occur in rare cases. For this feature 
to apply to models created in earlier versions of the software, the bridge object must be 
updated. All newly created bridge objects will use this feature. 

Graphics 
Enhancements Implemented 

* Ticket # Description 
 2727 The option View > Display Options > General Options > “Show Guide Structure Response” 

has been changed to “Show Guide Structure”. Previously guide structure objects, when present 
in the model, were always shown when plotting the undeformed shape using the Analysis > 
Show Tree command to view staged construction load cases, and the option "Show Guide 
Structure Response" only applied to plotting response results. Now the option "Show Guide 
Structure" will apply to the undeformed shape as well. Note that this option only affects staged 
construction load cases that use guide structures. 

Installation and Licensing 
Enhancements Implemented 

* Ticket # Description 
* 2754 The version number has been changed to v21.2.0 for a new intermediate release. 

Results Display and Output 
Enhancements Implemented 

* Ticket # Description 
 2704 An enhancement has been implemented for bridge superstructure design of concrete flat-slab 

bridges per the Indian IRC-2011 code in which the calculated total area of reinforcement 
required at specified distances from the top and bottom of the section to achieve a D/C ratio of 
unity can now be plotted in the Bridge Response Display form. Note that the calculation of the 
required total area of reinforcement was previously implemented in the CSiBridge version 
21.1.0, but the results were only available in the tables. 

* 3204 An enhancement has been made to display load combination results on a step-by-step basis for 
Linear Add load combinations of load cases that may contain one or more stepped load cases. 
Both on-screen display and tabulated results are now available. Max/min results were always 
available. Design is not affected as it already had the option for step-by-step design. 

* 3205 An enhancement has been made to output nonlinear energy components (nonlinear hysteretic 
damping and nonlinear viscous damping) per group for nonlinear load cases. The nonlinear 
energy is reported separately for model objects (internal element energy) and support elements 
(support element energy). The energy output is available in the "Element Nonlinear Energy By 
Group" table and "Energy by Group" type function in using the Display > Plot Functions 
command. 
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Structural Model 
Enhancements Implemented 

* Ticket # Description 
 2817 The New Model form (command File > New) has been enhanced to allow specification of the 

region to be used when automatically creating material properties when section properties 
and/or objects are added to the model. This option is only applicable when the model is 
initialized from defaults, not from a settings file or an existing model. Materials available for 
different regions are defined by material-definition files in the Property Libraries sub-folder 
where CSiBridge is installed, and can be expanded by adding similar files to the Property 
Libraries sub-folder in the user settings folder for CSiBridge. 
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Analysis 
Incidents Resolved 

* Ticket # Description 
* 2896 An incident was resolved where adding and running a nonlinear staged-construction load case 

to a model that had already been run and had results available could produce incorrect results 
if the added load case contained bridge Pour Concrete and Remove Forms operations. When 
the model was locked, the Pour Concrete and Remove Forms in the newly added load case 
would act on the entire structure rather than just on the group specified for these operations. 
Unlocking the model and running again would produce the correct results. 

* 2948 An incident was resolved where, for nonlinear static, staged-construction, direct-integration 
load cases, and sequences of such load cases, the frame member forces and stresses used for 
display and design could have been incorrect for a specific frame member when the following 
conditions are met: 
1. The load case (or sequence of load cases) contained more than one load pattern that applies 
loads directly to the frame member, including at least one load pattern with self-weight loads. 
2. A load pattern containing self-weight load (A) was applied after another load pattern 
containing frame loads (B); in other words, A was listed after B in the list of applied loads in 
the load case definition (or sequence). 
3. The load patterns A and B had different scale factors.  
Frame members that did not meet the above conditions, such as those without frame loads 
assigned to the load patterns used in the load case sequence, were not affected. Load case 
sequences without self-weight applied were not affected. Load case sequences having only one 
self-weight load pattern applied and with that load pattern being listed first in the load case 
definition were not affected. Note that this error did not affect how the frame loads were 
transferred to the structure, and therefore all other analysis results were correct (displacements, 
reactions, forces and stresses in other objects). Nonlinear behavior, including frame hinges and 
P-delta, was not affected. Only the reported forces and stresses within the affected frame 
members themselves were in error, including the forces used for frame design of those 
members. Because self-weight is most commonly applied first, most models were not affected 
by this error. Linear load cases were not affected, even if they used the stiffness from a 
nonlinear load case. This error affected CSiBridge versions 20.2.0 to 21.1.0. 

* 3035 An incident was resolved where, for nonlinear static, staged-construction, direct-integration 
load cases, the frame member forces and stresses used for display and design could have been 
incorrect for a specific frame member when the following conditions were met: 
1. Results were requested for multiple load cases at the same time, including situations where 
one or more requested load combinations referenced multiple load cases. 
2. Among all the requested load cases, only one of these was a nonlinear static, staged-
construction, or direct-integration time-history load case, and only a single step was requested 
from that load case. 
3. Among all the requested load cases, at least two of these were linear load cases (including 
modal or response-spectrum), at least two of these load cases used the stiffnesses from 
different nonlinear load cases (or zero initial conditions), and at least one of these was a linear 
static, linear multistep static, or modal time-history load case. 
4. The affected frame object had loads assigned to it as part of the single nonlinear load case. 
This could include self-weight. 
This was not common. When this error occurred, the frame response reported in the affected 
object could be incorrect at all stations along the length of the object except at the start (I end). 
For frame objects that were discretized into multiple elements for analysis, the results would 
be correct at the start of each element and deviate along the length of the individual elements. 
This deviation in response, when present, was due to using the wrong element load for 
equilibrium calculations. This error would be most likely to affect table results when multiple 
load cases or load combinations were requested, and frame design when the load combinations 
used satisfy the conditions listed above. Note that this error did not affect how the frame loads 
were applied to the structure, and therefore all other analysis results were correct 
(displacements, reactions, forces and stresses in other objects). 
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Bridge Design and Rating 
Incidents Resolved 

* Ticket # Description 
* 2589 An incident was resolved for bridge superstructure design and rating of precast concrete I-

girder and U-girder bridges where the various design/rating requests could fail to run when a 
nonprismatic frame section was assigned to be used for the precast girders in a bridge section. 
This has been corrected. An additional check has been added for nonprismatic precast sections 
during bridge design and rating: If a different material property is assigned to the sections at 
beginning and end of a segment in a nonprismatic frame section, the design/rating request will 
report this as an error for the affected section cuts and they will not be designed or rated. 
However, unaffected section cuts will proceed with the design/rating process. 

 2729 An incident was resolved for bridge rating of steel U-girder bridges per the AASHTO code 
where a strength rating request created in CSiBridge version 21.0.2 or earlier could not be run 
when the model was opened in version 21.1.0. The rating request could be run if the complete 
model was imported from a text file (.B2K or .$BR) or database-table file (Excel, Access, 
XML). No results were affected for load cases and design requests that could be run. 

Bridge Modeler 
Incidents Resolved 

* Ticket # Description 
* 2714 An incident was resolved for the Bridge Modeler where bridge line and area loads that were 

specified to act in a Local or Projected direction with respect to the layout line were generated 
based on the local coordinate system at the beginning station specified for the load, rather than 
adjusting to the change in local coordinate system if the layout line was curved or kinked. This 
did not affect bridge line or area loads assigned to a straight portion of the layout line, nor did it 
affect loads specified to act in the Global or other fixed coordinate system. Local loads will 
now change direction with the layout line. Projected loads do not change direction, but will now 
change magnitude according to the projection of the specified load direction upon the layout 
line. 

* 2719 An incident was resolved for the Bridge Modeler where bridge loads (point, line, and area) 
assigned near either end of the bridge could be completely or partially ignored if the bridge 
layout line had non-zero grade near the bridge ends. The affected region was very small, being 
equal to the grade times the half thickness of the top slab. As such, only point loads at the end 
of the bridge were significantly affected. Line and area loads were only affected over that small 
region, and the effect was insignificant for loads of length significantly longer that the slab 
thickness. This error occurred with negative grade at the bridge start or positive grade at the 
bridge end. 

 2722 An incident was resolved for the Bridge Modeler that corrected two issues associated with 
haunch loading for composite bridge sections (steel I-girder, steel U-girder, and precast 
concrete I-girder): (1) When the haunch load method specified in the bridge section was User 
Defined, the equivalent haunch point loads applied on the girder during the staged-construction 
operation “Pour Concrete” were calculated incorrectly; the load per-unit-length was not being 
multiplied by the length of the girder segments. This typically meant that the load was 
underestimated. (2) When the concrete haunch height was zero anywhere along the length of 
the girder, the haunch load was typically not calculated along the entire length of the girder. 
When opening an affected model in the new version of the software, it will be necessary to 
update the linked bridge model in order to correct these errors. 

 2743 An incident was resolved for the Bridge Modeler where, for steel I-girder bridges, the 
connection plate for a staggered diaphragm would not be properly connected to the girder if the 
staggered diaphragm was assigned too close to a highly skewed support and the vertical slope 
(grade) near the support was non-zero. Models that exhibit this issue in an older version of the 
software will need their bridge objects to be updated after opening them in the new version to 
correct the issue. 
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* Ticket # Description 
 2825 An incident was resolved for the Bridge Modeler where the rigid link objects generated at 

abutments and bents that connect the top of support bearings to the bridge superstructure were 
sometime created in the wrong location. This could occur when (1) the bearing assignment type 
was General, and also (2) bridge tendons modeled as elements were present at the abutment or 
bent. When this occurred, the connectivity between the superstructure and abutment or bent was 
lost, and the effect on the behavior of the model was obvious. This error usually only occurred 
when the bridge object was updated using the "Update Linked Model" command, not the "Clear 
and Create Linked Model" command. 

 2841 An incident was resolved in the bridge modeler in which the bridge object initial station could 
not be modified when the bridge span data was defined By Station in the Bridge Object Data 
form. Defining the data By Length was not affected. This was a user interface issue only and 
did not affect results. 

 2842 An incident was resolved in which the program failed to generate the analysis model if any of 
the tendon line objects in the model were discretized such that the last two tendon layout points 
were closer than the merge tolerance. This error was introduced in v21.0.2. 

 2854 An incident was resolved for bridge model generation where bent bearing link objects could be 
created in the wrong location when the model was updated as an area object model and the 
present coordinate system was not the default Global coordinate system. 

* 2883 An incident was resolved where modifying a detailed foundation property could result in an 
abnormal condition error. 

* 2954 An incident was resolved for the Bridge Modeler where the frame sections generated for the 
piles in pile foundations used the material named "4000psi", if present, regardless of the 
material property assigned when the pile foundation was defined. If there was no material 
property named "4000psi", then a random existing frame section was assigned to the generated 
pile frame objects. Results agreed with the model as generated. 

 2994 An incident was resolved for the Bridge Modeler where the elevation of the frame object 
modeling a prismatic bent cap beam was always set based on the mid-height of the cap-beam 
frame section, which would be incorrect when the cap-beam section was not symmetrical for 
major bending moment. An example of this would be a T-beam used as a bent cap. The 
elevation was incorrect by the distance between the centroid and midpoint of the section. This 
error did not affect nonprismatic cap-beam sections, which are always located with respect to 
the top of the frame section. Frame sections that are symmetrical for major bending were not 
affected, since the centroid is at the midpoint of the section. 

 3041 An incident was resolved for the Bridge Modeler where spine models of steel I-girder bridges 
could be incorrectly generated if the bridge object contained staggered diaphragms that were 
not located at the global (entire-section) section cuts and the option “Mesh Slab at Critical Steel 
I-GirderLocations” was checked when updating the bridge object. In some cases, frame (line) 
objects representing the superstructure spine would be missing near the bents of corresponding 
spans. When this occurred, the error was visually obvious and results agreed with the model as 
generated. This did not affect models updated as area (shell) objects. 

 3079 An incident was resolved for the Bridge Scheduler where closing the form, while editing an 
individual schedule, using the "X" button at the top right corner of the form would modify the 
schedule instead of cancelling the changes. In this case, the schedule was duplicated and all 
operations were repeated at the bottom of the original schedule. Clicking OK or Cancel to close 
the form behaved as expected. 

Data Files 
Incidents Resolved 

* Ticket # Description 
 2786 An incident was resolved where CSiLoadOptimizer data files from previous versions could not 

be loaded into the current version. 



CSiBridge v21.2.0 ISO# RELBRG2120          2019-11-13 Page 8 of 10 

* Ticket # Description 
 3049 An incident was resolved where opening an old model while another model with results was 

already open would cause the results of the current model to be deleted if the prompt to save 
current changes was accepted. 

Database Tables 
Incidents Resolved 

* Ticket # Description 
 2715 An incident was resolved where the table named Tables Automatically Saved After Analysis 

was not imported from an Excel file. 
 3001 An incident was resolved where exporting data from the Tendon Response Form to Excel when 

the computer region settings used a comma for the decimal separator would result in incorrect 
results being displayed in the Excel sheet. 

Documentation 
Incidents Resolved 

* Ticket # Description 
 3188 An incident was resolved where Equation 4-7 of the Material Time-Dependent Properties 

Technical Notes was incorrect. The equation has been corrected in the documentation. This was 
a documentation issue and did not affect the results. 

Graphics 
Incidents Resolved 

* Ticket # Description 
 2310 An incident was resolved where the display of loads on the analysis (element) model did not 

work when in DirectX graphics mode. Minor corrections were also made for the display of 
loads on the object model in DirectX. The display of loads on both the element and object 
model when using Classical Graphics mode was not affected. 

 3199 An incident was resolved that addressed several issues with the graphical display in DirectX 
mode: 
1.) Solid face colors were not being displayed. 
2.) Frame labels were not centered. 
3.) Extruded shells with transparency were sometimes displaying internal triangle edges. 
4.) Point and area selection colors sometimes changed when zooming. 
5.) Bubble text colors could be incorrect. 
6.) The cut line was not displayed while drawing section cuts. 
7.) Area local-3 axis was sometimes reversed when drawing in plan and elevation. The local-3 
axis should point toward the user when drawing counter-clockwise or using the draw-rectangle 
option in 2-D. 
8.) The window zoom sometimes produced unexpected results when the grid-bubble size was 
excessively large. 
9.) When scrolling for values within the frame force/moment/stress diagram in the right-click 
“Diagrams for Frame Object” form, the red dot showing the corresponding location on the 
structural model did not move correspondingly. 
10.) The deformed shape display of shell objects was incorrect when the View Type was set to 
Offset or Extruded in the View Options form. 
11.) The option to display area colors by section property in the View Options form did not fill 
all objects. 
12.) The Print Graphics command did not show joint reaction values when they were displayed 
on the screen. 
13.) Area joint offsets were not being considered when displaying extruded view. 
14.) Joint pattern values were not being displayed. 
15.) The display of frame distributed loads didn't show loading applied in two different 
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* Ticket # Description 
directions for a single load pattern. Only loading in one of the directions was displayed. 
16.) When displaying frame hinge assignments in a 2-D view, the text labels were not shown at 
the correct locations. 
17.) The multi-select option was not properly activated by using CTRL + left-mouse-click. 
18.) Snapping to a midpoint of another object when drawing an area object in a 3-D view could 
sometimes create the joint at an unexpected location.  
19.) Contour plots of area-object response (forces/moments/stresses) were sometimes incorrect 
when the joint-averaging option was used. If the value at three corners of an element were 
nearly equal, the value at the fourth corner would be plotted the same even if it should be 
different. The error was generally small, and no other results were affected. 

Results Display and Output 
Incidents Resolved 

* Ticket # Description 
 2745 An incident was resolved in which the display of concrete box bridge stress design check 

results was not working on the Bridge Object Response Display form. This was inadvertently 
introduced in v21.1.0, but was only a display issue. The results were still correct and available 
via the database tables. 

 3092 An incident was resolved for bridge superstructure design of steel I-girder bridge sections 
where the detailed design calculation report incorrectly showed the force in bottom rebar of the 
concrete slab as zero when calculating the negative plastic moment. This error affected only 
this single value in the calculation report. Values presented in the tables of design results were 
not impacted. No other values were affected. 

* 3095 An incident was resolved where tabulated analysis results may have been displayed as zero for 
load combinations that contained one or more Linear Add type load combinations. When this 
issue occurred, the tabulated results for a Linear Add type load combination that contained 
another Linear Add type load combination could have been displayed as zero. This issue only 
occurred when the following conditions were met: 
1. The model included multiple load combinations that each contained the same Linear Add 
type load combination (say "A") in its definition. 
2. In the Choose Tables for Display form (Display menu > Show Tables), more than one of the 
containing load combinations were selected for output. 
3. At least one of the selected load combinations containing combination "A" must have been 
of type Linear Add, and at least one must have been of a different type (e.g. Envelope). 
Any load combination containing affected load combinations could also be affected. This issue 
only affected the tables under the Analysis Results section. This issue did not affect visually 
displayed results or design results. This issue did not affect load combinations that were not 
nested. This issue was only present in CSiBridge version 21.1.0. 

* 3170 An incident was resolved where the plotted deformed shape for mode-based load cases was 
incorrect at joints having local coordinate systems different from the default (global axes). The 
displacement values plotted and shown in local coordinates (U1, U2, ..., R3) were actually the 
values in global coordinates (UX, UY, ... RZ). This affected the plotted shape, the values 
displayed when the mouse was moved over a joint, the values shown when right-clicking on a 
joint, and videos made of the deformed shape. Similarly, the joint displacements reported in the 
two database tables "Joint Displacements" and "Joint Displacements - Absolute" were always 
the displacements in global coordinates rather than the expected joint local coordinates. Plot 
functions were not affected. This error affected modal, response-spectrum, and linear and 
nonlinear (FNA) modal time-history load cases, as well as load combinations containing these 
load cases. No other types of load cases were affected. All other response quantities 
(displacements, forces, stresses) and design results throughout the model were correct and 
unaffected. This reporting error only affected version 21.1.0 of CSiBridge. 
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User Interface 
Incidents Resolved 

* Ticket # Description 
 2898 An incident was resolved where attempting to add the NZS 1170.5-2016 response spectrum 

function via the New button in the Functions - Response Spectrum pane of the ribbon would 
incorrectly attempt to add the old NZS 1170.4-2004 function. 
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